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Signing in to Aurora

1 SIGNING IN TO AURORA

Navigate to the Aurora site URL provided by your administrator.

Sign in

Username

Password

Powered by Aurora v2.5.0.29 [Package 2.5.64] © 2022 Condrey Corporatior

Figure 1 - Aurora sign-in screen

Enter the username using one of the following formats:

¢ Domain\Name — for example, CCTEC\bob
e User Principal Name — for example, bob@corp.cctec.org
e Simple name format — for example, Bob
Names in this format assume the domain of the Aurora server.

Enter your password, then hit Enter or click Sign in to authenticate into Aurora.


mailto:bob@corp.cctec.org

Navigating the Site

2 NAVIGATING THE SITE
2.1 My Files

AURORA & My Files 2 Bob Data Owner ~
Home View
u " X I { f ; g E Select all
= Ml 15 Select none
New Upload
folder g - DD Invert selection
Clipboard Organize New Transfer Open Compression Select
4 7 » Home > Shared » Project Catapult ] Search Project Catapult

v " Home
-

_ archived —
| Projects }‘3
v 7 Shared PDF

__ Alpha Test 33

. N Weekly Reports ACME-X500- Installation.docx system.log
v Project Catapult InstallGuide.pdf

_ Weekly Reports

Powered by Aurora v2.5.0.29 [Package 2.5.64] © 2022 Condrey Corporation.

4 items B:=

Figure 2 - Main page without Sharing enabled

By default, without Sharing enabled, the interface contains just the My Files file management
interface. This interface is presented in a similar fashion to Windows Explorer.

For details on the File Management interface, refer to section 3 Accessing the File Management
Interface.



2.1.1 Selected Folder Sharing Info

RA & My Files

[® My Shares

Navigating the Site

2 Bob Data Owner ~

Selected Folder

Path:
Home\Shared\Project Catapult

Allowed Permissions:
e Full

Maximum Days to Share:
45

[ Share Folder

Home View

0" X =f

* New

folder
Clipboard Organize New
M © > Home * Shared * Project Catapult

v . Home
_ archived
__ Projects
v [ Shared
__ Alpha Test 33

- 5 1 Weekly Reports
¥ Project Catapult

Weekly Reports

4 items
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Figure 3 - Main page with Sharing enabled

If sharing has been enabled, users will also be presented with a Selected Folder sharing info panel.
For details on sharing folders with Guest users, see 4 Sharing Content with Guests.

2.2 My Shares

When sharing is enabled, the My Shares menu option is also available. See section 6 Managing
Existing Shares for information on managing existing shares.




Navigating the Site

2.3 My Profile

To view profile data for your account and to setup or modify two-factor authentication, select the
My Profile menu option at the upper right-hand corner of the page:

& My Files [ My Shares & Bob Data Owner «
¥= My Profile
. [» Logout
PROFILE il
Name: Bob Data Owner

Account Name: CCTEC\bob
Account ID: S-1-5-21-4292135720-1078627195-3576196312-34606

Registered On:  2022-08-11 14:16:42

TWO-FACTOR AUTHENTICATION

One-time Password: [N Register 2FA Device

https://aurora.cctec.org/Profile Powered by Aurora v2.5.0.29 [Package 2.5.64] © 2022 Condrey Corporation.

For details on managing your two-factor authentication, see section 5 Two-Factor Authentication
(2FA).



2.4 Signing Out

Navigating the Site

To sign out of Aurora, select the Log out menu option at the upper right-hand corner of the page:

5 Aurora

« > C

& My Files

Selected Folder

Path:
Home\

Allowed Permissions:
* None

Unlimited

[ Share Folder

Maximum Days to Share:

(8 https://aurora.cctec.org

[ My Shares

Home View

g X 3

*| oo s Delete R

Clipboard Organize

+ :3 Home

v __ Home
T archived
" Projects

» 7 Shared

3 items
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Figure 4 - Logging out




Accessing the File Management Interface

3 ACCESSING THE FILE MANAGEMENT INTERFACE
3.1 Layout

The File Management interface is designed to have a similar look and feel as Windows Explorer.

A folder navigation pane is presented on the left, and a detail pane on the right.

& My Files = [ My Shares
Home View
Selected Folder
U b x I f ESe\e[tall
= /Ll 151 Select non
Path: * N gy EFH it sel jz
i fold - 5 Invert sele:
Home\Shared\Project Catapult e
Clipboard Organize New Transfer Open Compression Select
4 > Home » Shared » Project Catapult ] Search Project Catapult »p

Allowed Permissions:

e Full ~ " Home
7 archived
Maximum Days to Share: 70 Projects
v . Shared

45

[ Share Folder
4

~ Alpha Test 33

~  Project Catapult

Weekly Reports

4 items
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Figure 5 - Layout



Accessing the File Management Interface

3.2 Options Availability

For internal users, all operations are shown as available. However, depending on the assigned
permissions in the file system, not all operations will work successfully.

Home Yiew

5 [ % X =P ¥ 4+ K [ it

Copy Delete Rename MNew Download Upload Open Add to
folder zip... - DD Invert selection

For example, if you try creating a new folder in a read-only share, you will see an error message like
the following:

Action Error pod

@ (3) Access is denied: [[Employee Resources]\\Projects]

QK

Since you as an internal user are authenticating to Aurora using your Active Directory credentials, all
existing Windows share and file system permissions still apply.

10



Accessing the File Management Interface

3.3 Basic Operations

4 Download Download a file or folder
4" Upload Upload a file
J= Preview View a document or media file
=4 Open Open a folder or compressed file
¢ Add to zip Add files or folders to a compressed file
', Extract all Extract files and folders from a compressed file
= Copy Copy a file or folder
4, Cut Cut a file or file (for use as part of a move operation)
|j Paste Paste a copied file (copy operation) or cut file (move operation)
New folder Create a new folder
-ﬁ Rename Rename a file or folder
X Delete Delete a file or folder

3.3.1 Download

To download a file or folder:

1. Select one or more files and folders from the navigation or detail pane.

2. Select ; Download from the ribbon toolbar or context menu to download the selected
entries.

©® Downloading a folder retrieves a zip archive of all that folder’s content. The download is named
based on the folder.

©® Downloading multiple selections at the same time retrieves a zip archive of all those contents.
The zip is named based on the first selected item.

11



Accessing the File Management Interface

3.3.2 Upload

To upload a file or folder, use the Upload Dialog (Option 1) or simply drag-and-drop selected entries
from Windows File Explorer into the browser (Option 2):

Option 1
1. Select 1' Upload from the ribbon toolbar or context menu.

Upload Files - stuff o X

f Select files to be uploaded

Drag and drop files and folders here.

Add files... Add folders... Remove Clear Upload

2. Add one or more files and folders to be uploaded by dragging files from the Desktop or

Windows Explorer into the file drop area, or by clicking Add files or Add folders in the upload
dialog.
3. Click Upload to send the files to the selected folder.

Option 2
Alternatively, files and folders may be directly copied via drag-and-drop.

1. Navigate to the desired target folder in a Guest Share.
2. Using Windows Explorer, select one or more files and folders.
3. Drag the selected items onto a folder in the navigation pane or into the folder’s detail pane.

12



Accessing the File Management Interface

3.3.3 Preview

Many common document and media types may be viewed directly in the browser.

To preview a document or media file:

1. Select the file to preview. Ifitis a valid preview type, the /4 Preview ribbon item and context

menu will be enabled.

2. Select g Preview from the ribbon toolbar or context menu.

& My Files = [ My Shares

Bob Data Owner ~

Selected Folder Project Catapult.docx - Document Viewer

@ mQ

Path:
Home\Shared\Pj

Allowed Permist
e Full

roject Catapult

Maximum Days
45

[ Share Fold

©® €«
Q QO

Powered by Aurora v2.5.0.29 [Package 2.5.64]

Project Overview

Lorem ipsum doler sit amet, consectetuer adipiscing elit. Maecenas porttitor congue massa. Fusce
posuere, magna sed pulvinar ultricies, purus lectus malesuada libero, sit amet commodo magna eros
quis urna. Nunc viverra imperdiet enim. Fusce est. Vivamus a tellus. Pellentesque habitant morbi
tristique senectus et netus et malesuada fames ac turpis egestas. Proin pharetra nonummy pede. Mauris
et orci. Aenean nec lorem. In porttitor. Donec laoreet nonummy augue. Suspendisse dui purus,
scelerisque at, vulputate vitae, pretium mattis, nunc. Mauris eget neque at sem venenatis eleifend. Ut
nonummy. Fusce aliquet pede non pede. Suspendisse dapibus lorem pellentesque magna. Integer nulla.
Donec blandit feugiat ligula. Donec hendrerit, felis et imperdiet euismod, purus ipsum pretium metus, in
lacinia nulla nis| eget sapien. Donec ut est in lectus consequat consequat. Etiam eget dui.

Aliquam erat volutpat. Sed at lorem in nunc porta tristique. Proin nec augue. Quisque aliquam tempor
magna. Pellentesque habitant morbi tristique senectus et netus et malesuada fames ac turpis egestas.
Nunc ac magna. Maecenas odio dolor, vulputate vel, auctor ac, accumsan id, felis. Pellentesque cursus
sagittis felis. Pellentesque porttitor, velit lacinia egestas auctor, diam eros tempus arcu, nec vulputate
augue magna vel risus. Cras non magna vel ante adipiscing rhoncus. Vivamus a mi. Morbi neque.
Aliquam erat volutpat. Integer ultrices lobortis eros. Pellentesque habitant morbi tristique senectus et
netus et malesuada fames ac turpis egestas. Proin semper, ante vitae sollicitudin posuere, metus guam
faculis nibh, vitae scelerisque nunc massa eget pede. Sed velit urna, interdum vel, ultricies vel, faucibus
at, quam. Donec elit est, consectetuer eget, consequat quis, tempus quis, wisi. In in nunc. Class aptent
taciti sociosqu ad litora torquent per conubia nostra, per inceptos hymenaeos. Donec ullamcorper
fringilla eros. Fusce in sapien eu purus dapibus commodo.

Cum sociis natoque penatibus et magnis dis parturient montes, nascetur ridiculus mus. Cras faucibus
condimentum odio. Sed ac ligula. Aliquam at eros. Etiam at ligula et tellus ullamcorper ultrices. In
fermentum, lorem non cursus porttitor, diam Urna accumsan lacus, sed interdum wisi nibh nec nisl. Ut
tincidunt volutpat urna. Mauris eleifend nulla eget mauris. Sed cursus quam id felis. Curabitur posuere
quam vel nibh. Cras dapibus dapibus nisl. Vestibulum quis dolor a felis congue vehicula. Maecenas pede
purus, tristique ac, tempus eget, egestas quis, mauris. Curabitur non eros. Nullam hendrerit bibendum
justo. Fusce faculis, est quis lacinia pretium, pede metus molestie lacus, at gravida wisi ante at libero.
Quisque ornare placerat risus. Ut molestie magna at mi. Integer aliquet mauris et nibh. Ut mattis ligula
posuere velit. Nunc sagittis. Curabitur varius fringilla nisl.

0

© 2022 Condrey Corporation.
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Figure 6 - Preview a document using the built-in viewers

For documents, depending on the document type, the previewed document may be printed or saved

as a PDF.
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Accessing the File Management Interface

3.3.4 Open

The Open operation opens or expands a folder or zip file. To open a folder or zip file:

1. Select afile or folder from the navigation or detail pane.

2. Select ﬂ- Open from the ribbon toolbar or context menu.

3.3.5 Create a New Folder

To create a new folder:

1. Select New Folder from the ribbon toolbar or the context menu.
2. Enter the name of the new folder in the New Folder dialog.

Create Folder =

Enter a name for the new folder:

e ol

QK Cancel

3. Click OK to save the name.
3.3.6 Delete
To delete a file or folder:

1. Select afile or folder from the navigation or detail pane.

2. From the ribbon toolbar or context menu select % Delete.
3. Click Yes in the confirmation dialog.

Delete File -

o Are you sure you want to delete this file?

Project Crossbow - Work in Progress.zip

Yes No

14



Accessing the File Management Interface

3.3.7 Rename

To rename a file or folder:

1. Select afile or folder from the navigation or detail pane.

2. From the ribbon toolbar or context menu select '—i' Rename.

Rename lkem hod

Enter a new name for the item:

Mew Project Files.zip

QK Cancel

3. Enter the new name, then click OK.
3.3.8 Copy (Copy-and-Paste)
To copy a file or folder:

Select one or more files and folders to copy.

Select " Copy from the ribbon toolbar or context menu.
Navigate to or select the target folder.

p wbdBE

Select E Paste from the ribbon toolbar or context menu to copy the contents to the target
location.

15



3.3.9 Move (Drag-and-Drop)

To move a file or folder via Drag and Drop:

Accessing the File Management Interface

1. Select afile or folder from the navigation or detail pane.
2. While keeping the item selected, drag the file or folder to another folder in the detail pane or

the navigation pane.

AURORA & MyFiles [ My Shares
Home  View
B0 Xl 1 ¥4
Copy Delete Rename  New  Download Upload
folder
Clipboard Organize New
* > Home » Shared » Project Catapult »
v . Home
archived
Projects
v Shared
Alpha Test 33

A meme |

& Bob Data Owner ~

a ]
E 3 i [ select all
1+ / Select none
Open Preview Addto =
&9 Invert selection

zip.
Compressio

(<]

Search Project Catapult

Weekly Reports  ACME-X500

W Project Catapult

Weekly Re;ﬁns

W—"qorts

-» Move to Weekly Reports
Hold down CTRL to copy
Press ESC to cancel

Sitems  1item selected 33.1KB

InstallGuide.pdf

Powered by Aurora v2.5.0.29 [Package 2.5.64]

Installation.docx Project system.log

Catapult.docx

]

© 2022 Condrey Corporation,

Figure 7 - Moving files via drag-and-drop

3. Release the selection when the target folder is activated.

In some cases, you may see this error:

Action Errar

QK

e {17) The system cannot move the file to a different disk drive:

Pt

A cut-and-paste or move operation is treated as a single file system operation, so in cases where the
source and target paths are on separate drives or volumes, a different approach must be taken.

16



Accessing the File Management Interface

5.

Select a file or folder to move from the navigation or detail pane.

Select 2 Copy from the ribbon toolbar or context menu.

Navigate into the target folder or right-click on the folder from the detail or navigation pane,
then select B Paste.

Navigate back to the original folder.

Reselect the source object, then select X Delete from the ribbon toolbar or context menu.

3.3.10 Move (Cut-and-Paste)

To move a file or folder via Cut-and-Paste:

1.

2.
3.

Select a file or folder from the navigation or detail pane.

Select @ Cut from the ribbon toolbar or context menu.
Navigate into the target folder or right-click on the folder from the detail or navigation pane,

then select |:| Paste.

In some cases, you may see this error:

Action Errar ot

e (17) The system cannot move the file to a different disk drive:

oK

A cut/paste or move operation is treated as a single file system operation, so in cases where the

source and target paths are on separate drives or volumes, a different approach must be taken.

1.

2.
3.

17

Select a file or folder to move from the navigation or detail pane.

Select Copy from the ribbon toolbar or context menu.

Navigate into the target folder or right-click on the folder from the detail or navigation pane,
then select 5| Paste.

Navigate back to the original folder.

Reselect the source object, then select X Delete from the ribbon toolbar or context menu.



Accessing the File Management Interface

3.3.11 Add to Zip

To add one or more files and folders to a new zip archive:

1. Select the files and folders to be added.

2. Select ¢ Addto zip from the ribbon toolbar or context menu.

Add ltems to Zip >

Enter a name for the zip file:

Project e

QK Cancel

3. Specify the name of the zip file, then click OK.

Note that this process only creates a new zip file. To add files or folders to an existing zip file:

1. Select the files and folders to be added.
2. Select " Copy or > Cut from the ribbon toolbar or context menu.

3. Navigate into the target zip file, then select B Paste.

18



Accessing the File Management Interface

3.3.12 Extract from Zip

To extract a zip file:

1. Select the zip file to extract.

2. Select g2 Extract all from the ribbon toolbar or context menu.
3. Inthe sub-select menu, choose Extract all to or Extract all here

| PDF |

(Bl L L

P €

Open

Project Files Project Files.: Download

Review.pdf Upload

! Addto Ziph..

s Extract all @ }| Extract all to...
Cut Extract all here

Copy

Delete

Fename

05 L X & 8<

Invert selection

4. If Extract all to was selected, specify the name of a sub-folder to create and extract the
contents into.

Extract ltems From Archive o

Enter a folder name to extract the archive file to:

O 5y

OK Cancel

19



3.4 View Options
3.4.1 Navigation Pane

The navigation pane may be collapsed or expanded by using the splitter bar toggle option.

& My Files

Accessing the File Management Interface

[® My Shares

Bob Data Owner ~

Selected Folder

Path:
Home\Shared\Project Catapult

Allowed Permissions:
* Full

Maximum Days to Share:
45

[ Share Folder

Home View
* New
folder
Clipboard Organize New
A " » Home > Shared » Project Catapult

v 20 Home
7 archived
" Projects

v Shared
" Alpha Test 33

= - Weekly Reports
v Project Catapult

" Weekly Reports

4 items

Powered by Aurora v2.5.0.29 [Package 2.5.64]

f ; m Select all

. e 4 15 Select non
Upload jE

- EF Invert sele:

Transfer Open Compression Select

®  Search Project Catapult r

PDF
ACME-X500- Installation.docx system.log

InstallGuide.pdf

© 2022 Condrey Corporation.

Figure 8 - Navigation panel splitter bar collapse option

20



Accessing the File Management Interface

In addition, the navigation pane may be hidden altogether:

& My Files [® My Shares 2 Bob Data Owner ~
Home View
Selected Folder
u a x I { i f ‘ g g ESe\ect all
] /1
o 10 Select non:
Path: * New Upload |jDI e jz
. - 1 Invert sele
Home\Shared\Project Catapult folder
Clipboard Organize New Transfer Open Compression Select
> Home » Shared » Project Catapult » ] Search Project Catapult P

Allowed Permissions:

5 items

e Full )
z
o
=
. oo
Maximum Days to Share: ES }Q
Q
45 = PDF
Weekly Reports ACME-X500- Installation.docx Project system.log

InstallGuide.pdf Catapult.docx
[* Share Folder

Powered by Aurora v2.5.0.29 [Package 2.5.64] © 2022 Condrey Corporation.

Figure 9 - Collapsed navigation pane

1. Select the View tab on the ribbon toolbar.

2. Click the (¥ Navigation pane button to toggle the visibility of the navigation pane.

21




Accessing the File Management Interface

3.4.2 Detail Pane

The items in the detail pane may be displayed as icons or as a detail list.
To change the detail display:

1. Select the View tab on the ribbon toolbar.
2. Click the display option in the Layout ribbon group.

Home View

I:I Extra large icons

Medium icons [ Small icons

MNavigation __ =
pgne B== Details B Tiles
Panes Layout

Alternately, a simple toggle between the current icon size and the detail view is available in the
bottom right corner of the detail pane:

& My Files [ My Shares 2 Bob Data Owner ~
Home: View
Selected Folder
u * x I [ ) f i s FH select al
. T\ : A 1 Select non
Path: & New Upload [jDI - jE
. - * Invert sele
Home\Shared\Project Catapult folder
Clipboard Organize New Transfer Open Compression Select
o ™ » Home » Shared » Project Catapult o Search Project Catapult »
Allowed Permissions:
e Full v . Home
archived —_— \
Maximum Days to Share: Projects }:
45 v Shared PDF

Alpha Test 33
. 1 Weekly Reports ACME-X500- Installation.docx system.log
~ Project Catapult_ InstallGuide.pdf

[e® Share Folder Weekly Reports

4 items = l

Powered by Aurora v2.5.0.29 [Package 2.5.64] © 2022 Condrey Corporation.

Figure 10 - Detail pane view toggle
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Sharing Content with Guests

4 SHARING CONTENT WITH GUESTS

If Aurora has been setup for Sharing, Internal Users may be able to share certain folders with Guest
users. Guest users are identified by their email address and may exist outside the organization.

Depending on the allowed share permissions setup by the Aurora administrator, users may be
allowed to give full access to a particular folder or may be restricted to a limited set of permissions,
such as just Download or View.

To share a folder with Guest user:

1. Select the folder to share from the folder navigation tree.
Verify the selected folder name in the Share Info panel. Also, note that the Allowed
Permissions and Maximum Days to Share will vary based on rules established by the Aurora
administrator.

Selected Folder

Path:
Home\Shared\Project Catapult

Allowed Permissions:
e Full

Maximum Days to Share:
45

[* Share Folder

Figure 11 - Selected folder share options
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Sharing Content with Guests

3. Click Share Folder from the Share Info panel.

Share a Folder

Path: \\cct-2016.corp.

cctec.org\HOME\bob\Shared\Project Catapult

Share Name:*  Project Files - 20220811

SUENGLIESA bsmith@outsideorg.com [ x)

Enter one or more email addresses separated by a comma [, ] or semicolon [ ;1.

Permissions:*  Basic

D Full Control Provides full control of files and folders
O Upload Provide files
Download Retrieve files
View View documents and media in the browser
Advanced
Start Time:* 8/M1/202212.00AM -
Stop Time:* 8/18/202212:00 AM  ~ © Maximum share time: 45 days

Description:

Characters remaining: 1000

SUBMIT

Figure 12 - Creating a new share
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Sharing Content with Guests

4.

8.
9.

Modify the share name (Optional). A default share name is provided based on the selected
folder, but this may be modified as desired.

Enter one or more target email addresses. Multiple addresses may be separated by a
comma (, ) or a semicolon ( ;).

Select the desired share permissions.

Optionally, click Advanced to define a more specific set of permissions, such as Delete or
List Files and List Folders.

Note that some permissions may be disabled if they are not part of the Allowed Permissions
list for this folder.

Select the start and stop share times.

Note that the share time may be limited based on the rules in place for this folder.

Enter a description. (Optional)

Click Submit to save the settings and send the Share notification.

Once a new share has been defined, a notification email is sent to the email target defined in the

share providing the Guest user the URL for accessing the Aurora Guest Share.
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Two-Factor Authentication (2FA)

5 TwO-FACTOR AUTHENTICATION (2FA)
5.1 Access 2FA Registration and Status

To view or modify two-factor authentication (2FA) registration, select the My Profile menu option from
the user menu at the upper right-hand corner of the page:

& My Files [ My Shares

Bob Data Owner «

PROFILE

Name:
Account Name:
Account ID:

Registered On:

https://aurora.cctec.org/Profile

Bob Data Owner

CCTEC\bob
S-1-5-21-4292135720-1078627195-3576196312-34606
2022-08-11 14:16:42

TWO-FACTOR AUTHENTICATION

One-time Password: [N Register 2FA Device

Powered by Aurora v2.5.0.29 [Package 2.5.64] © 2022 Condrey Corporation.

¥= My Profile "

. [ Logout

Figure 13 — Viewing account and 2FA registration status
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Two-Factor Authentication (2FA)

5.2 Register 2FA Device or Application

To register a 2FA device or application:

1. Inthe Two-Factor Authentication section of the My Profile page, click Register 2FA Device.

& MyFiles [® My Shares a

a Bob Data Owner ~

REGISTER TWO-FACTOR AUTHENTICATION

MJFTKB55PZZ7VEKRMVYIMAQVACK7V5MF %

One-time Passcode

REGISTER

1. Scan the QR code using a Two-Factor
Authentication app on your mobile device or
enter the registration key directly in the app.

2. Enter the one-time passcode from your
Authentication app then click Register.

Powered by Aurora v2.5.0.30 [Package 2.5.66] © 2022 Condrey Corporation.

Figure 14 — Registering a 2FA device or application

2. Follow the instructions in the registration page to scan the QR code or entry the registration
key into a 2FA mobile or desktop application.
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Two-Factor Authentication (2FA)

3. From your 2FA application, select the registered application, then copy the six-digit code into
the One-Time Passcode field.

One-time Passcode

| 149122 |

REGISTER

4. Click Register to confirm the registration of the 2FA application.

& MyFiles [® My Shares & Bob Data Owner ~

REGISTER TWO-FACTOR AUTHENTICATION

JLRR4C6IJFHFCOWX3VWHSEQCXUL5YRZU li

One-time Passcode

149122

REGISTER

Vv Success

Continue to application

Powered by Aurora v2.5.0.30 [Package 2.5.66] © 2022 Condrey Corporation

Figure 15 — Successfully cleared 2FA registration

5. In the confirmation screen click Continue to application to return to the application.
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Two-Factor Authentication (2FA)

5.3 Clear 2FA Registration
To clear an existing 2FA registration:

1. Select the My Profile menu option from the user menu at the upper right-hand corner of the
page.

2. Inthe Two-Factor Authentication section, select Clear 2FA Registration.

3. Inthe confirmation dialog click Yes to clear the 2FA registration or No to cancel the
operation.

Clear 2FA Registration

Continuing with this process will invalidate your current 2FA

0 registration for this site.

Continue to clear your 2FA registration?

=

4. If Yes was selected the screen will refresh with a confirmation.

AURORA & My Files [® My Shares & Bob Data Owner ~
PROFILE
Name: Bob Data Owner

Account Name: CCTEC\bob
Account ID: 5-1-5-21-4292135720-1078627195-3576196312-34606

Registered On: 2022-08-11 14:16:42

TWO-FACTOR AUTHENTICATION

One-time Password: OG-S E YAV ]

" 2FA registration successfully cleared.

Powered by Aurora v2.5.0.30 [Package 2.5.66] © 2022 Condrey Corporation

Figure 16 — Successful Clear of 2FA Registration

You may be directed to re-register for two-factor authentication on the next sign-in if Aurora
policy requires it for your account.



Two-Factor Authentication (2FA)

5.4 Re-register 2FA Device or Application
To register two-factor authentication with a different application or device:

1. Clear any existing 2FA registration following the instructions in section 5.3 Clear 2FA
Registration.

2. Register a 2FA device or application using the instructions in section 5.2 Register 2FA Device
or Application.

30



Managing Existing Shares

6 MANAGING EXISTING SHARES

Click My Shares in the menu at the top.

& MyFiles [ My Shares A& Bob Data Owner ~

[ MY SHARES IZACTIVITY LOGS

Drag a column header here to group by that column

Share Name Shared With Shared Path Last Activity Last Access Time Start Time
# & X  [4 ProjectFiles - 20220811 |77 bsmith@outsideorg.com W\cct-2016.corp.cctec.org\HOME\bo...  Download 8/12/2022 9:47:36 AM 8/11/2022
N

Page 1 of 1 (1 items) o

Create Filter

Figure 17 - Viewing the list of existing shares

Management options for existing shares include:

e Edit the share

e Resend the email notification

e Delete the share

e Review Guest Account status via tooltip
¢ Review share status

e Review share activity
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Managing Existing Shares

6.1 Access Share Content

To access the content of an existing share, click the link represented by the Share Name, which

opens the share in a limited pop-out window.

#= Project Catapult_4 - Google Chrame - O *
@ https://aurora.cctec.org/Controls/FileBrowser?share_id=4
Home View
J 4 X f F E Hﬂ Select all
. o Select none
MNew Upload
fo d:r i - DD Invert selection
Clipboard Organize Ne Transfe Ope Compres Select
o r

* Project Catapult »

-~

v L Project Catapult

Archived Documents <> —— m

Archived Blueprints Contract Proposal

Documents Template

Bz

4 items

Figure 18 - Pop-out View of a Share

Multiple shares may be accessed simultaneously, enabling the user to see the provided content for
each.

Note that the rules defined in the Guest Share are not represented in this view.
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Managing Existing Shares

6.2 Modify a Share

To modify an existing share:

1. Click the pencil icon #" next to the share to modify.
2. Edit the Guest Share parameters. (Note that only the Permissions, Start Time, Stop Time,
and Description may be modified after the share is initially created.)

AURORA & My Files [@® My Shares & Bob Data Owner ~
[® MY SHARES = ACTIVITY LOGS

Share a Folder

Path: \\cct-2016.corp.cctec.org\HOME\bob\Shared\Project Catapult
Share Name:*  project Files - 20220811

Email Address:* | bsmith@outsideorg.com [ x)

Enter one or more email addresses separated by a comma [, ] or semicolon [;].
Permissions:*  Basic

D Full Control Provides full control of files and folders

%Upload Provide files

Download Retrieve files

View View documents and media in the browser

Advanced ~

Start Time:* 8/11/2022 12:00 AM
Stop Time:* 9/25/2022 12:00 AM © Maximum share time: 45 days

Description: Please review these files for next week.

Characters remaining: 960

SUBMIT

Powered by Aurora v2.5.0.29 [Package 2.5.64] © 2022 Condrey Corporation.

Figure 19 - Modifying an existing share

3. Click Submit to save any changes to the share.

4. The Guest account specified in the Email Address will be notified via email that an update to
the share has taken place.
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6.3 Resend Notification Email

To resend the notification email:

1. Click the email icon next to the share to resend.
2. Click OK in the confirmation dialog to resend the email.

6.4 Delete a Share

To delete an existing share:

1. Click the delete icon # next to the share you wish to delete.

2. Click OK in the confirmation dialog to delete the share.

Managing Existing Shares
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Managing Existing Shares

6.5 Review Guest Account Status

To review the status of a Guest Account associated with a share, simply hover over the share name.

D

AURORA & MyFiles [® My Shares

[e* MY SHARES IS ACTIVITY LOGS

rag a column header here to group by that column

Share Name Shared With Shared Path

# = X  [J ProjectFiles - 20220811

D bsmith@outsideorg.com% \\cct-2016.corp.cctec.org\HOME\bo...
@ -

BSMITH@OUTSIDEORG.COM

Email bsmith@outsideorg.com
Name Bob Smith

Organization ACME Organization

Last Login 8/12/2022 12:06:37 PM

Status v Active

Page 1 of 1 (1 items) o

Create Filter

2 Bob Data Owner ~

Last Ac

Downlc

Figure 20 - Guest Account Status

A tooltip with the following information on the Guest Account will display:

e Gravatar image, if available (defaults to anonymous user image)

e Username / email address
e First Last name

e Organization

e Last login time

e Current status (Active, disabled, locked out, expired, etc.)

o Avatar images are based on the Gravatar public avatar service which ties a user’s avatar image to
an email address. For more information, see http://gravatar.com.
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http://gravatar.com/

6.6 Review Share Status

AURORA & MyFiles [ My Shares

[ MY SHARES iIZ ACTIVITY LOGS

Drag a column header here to group by that column

Share Name Shared With

Page 1 of 1 (1 items) o

Create Filter

# & X [2Project Files - 20220811 bsmith@outsideorg.com

Managing Existing Shares

Shared Path

\\cct-2016.corp.cctec.org\HOME\bo...

L

Powered by Aurora v2.5.0.29 [Package 2.5.64] D 2022 Condrey Corporation.

2 Bob Data Owner ~

Last Activity

Download

Last Access Time

-

8/12/2022 9:47:36 A

Figure 21 — Share Status

The My Shares page includes the following status information for each share:

e Share Name

e Shared With

e Share Path

e Last Activity

e Last Access Time
e Start Time

e Stop Time

e Share Permissions
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Managing Existing Shares

6.7 Review Share Activity

To access activity audit logs for provided shares, click the Activity Logs tab in the My Shares page.

AURORA & MyFiles [® My Shares & Bob Data Owner ~
(@ MY SHARES = ACTIVITY LOGS
Drag a column header here to group by that column
ID Timestamp Client Account Target Path Client Address Activity Path1
273 8/12/2022 9:47:36 AM bsmith@outsideorg.com N \\cct-2016.corp.cctec.org\HOME\bo...  192.168.56.1 Download File
272 8/12/2022 9:47:23 AM bsmith@outsideorg.com \\cct-2016.corp.cctec.org\HOME\bo...  192.168.56.1 Preview File
271 8/12/2022 9:46:27 AM bsmith@outsideorg.com \\cct-2016.corp.cctec.org\HOME\bo...  192.168.56.1 Directory List s Di
270 8/12/2022 9:46:26 AM bsmith@outsideorg.com \\cct-2016.corp.cctec.org\HOME\bo... ~ 192.168.56.1 Directory List 8 Di
269 8/12/2022 9:46:19 AM bsmith@outsideorg.com \\cct-2016.corp.cctec.org\HOME\bo...  192.168.56.1 Directory List s Di
Page 1 of 1 (5 items) o
Create Filter
L] »
Powered by Aurora v2.5.0.29 [Package 2.5.64] © 2022 Condrey Corporation.

Figure 22 - Share Activity Audit Logs

Activity may be grouped by dragging column headers to the top of the grid area or filtered using the
filter row or filter icons at the top of each column.

Share activity audit logs are available for the lifetime of the share and may continue to be available for
a limited time thereafter based on the system configuration.
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